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Outlook Calendar - 2003

The Calendar feature in Outlook can be used to add appointments to your own or another
person’s agenda or to schedule meeting for which you invite other people to attend.

Open the Calendar from the Outlook Bar by clicking on the Calendar button or by selecting the
Folder List icon at the base of the Outlook Bar.

R T L L L ]
— Mail

] Calendar <——— Calendar Button

8 4 | a2 2
I

Folder List icon

. . Tod D work Week |7 week 31]Month
The Different Views gay||j a£|i=| orkWeek 7]esk 5i]Month |

The Outlook calendar can be viewed in a variety of ways and can be changed instantaneously.
Views can be used interchangeably and set up to enhance end user preference. The different
views can be selected from the Standard toolbar or from the View menu.

. . . 1 May 2006 3
Display the Navigator to your View SMTWTES
_ o _ o 301 2 3 456
The Navigator view is a one month view within the calendar. 7 8 9101112 13
View a specific day by selecting the day on the calendar. 14 15 16 17 18 139 20

21 22 23 24 25(26]27

Navigate between the month by selecting the Left or Right
28293031 1 2 3

navigation arrows.

Tip: display two months in the Navigator view by positioning the cursor on the vertical bar
between the Navigation Pane and the Calendar, left-click and drag to the right.

Current Wiew

. . . . ) ) o (%) Dayweek/Manth
Tip: display different view options in your Navigation Pane by ©) DayWeekiMorth View b

choosing View, Arrange by, Show Views in Navigation Pane. ) Active Appainkments

Events
g annual Events
D Recurring Appoinkrents
{:} By Category
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View Options:

fgw | Go Tools  HateSpam

arrange By 3 L]

Mavigation Pane  Alk+F1 .

Reading Pane 3

j Day

Work Week
j Week

E tanth

The Today view displays current day

The Day view displays one day at a time

= The Work Week displays one week, Monday — Friday, by default
0 The work week can be custom defined

= The Week view displays one calendar week

= The Month View displays one month at a time

Tip: Display a different Reading Pane for your calendar view by selection the View menu,

Reading Pane, and selecting Left, Right, or Off.

Wiews | Go Tools iHateSpam  Actions  Help
frrange By Y b 5] work wesk [5

| Mavigation Pane  Alk+F1 m

| Reading Pane 4 | [ Right

1] Day |5 Bottam

5] ‘wark Wesk Off k

Go to a Date
To quickly go to a specific date, press the Ctrl-G keys
on the keyboard. From here you may select the date

you want and also the view (Day, Week, Month, Work
Week).

Defining the Work Week

Define the Work Week by selecting Tools, Options,
Calendar Options.

= Select the check boxes next to the days of the
week that you want included in your work week.

= In the First day of week box, click

the day that you want. mET:

Go To Date

Show in;

IDay Calendar

Date: |ruesday, July 29, 2003 ﬂ
w

Cancel

Options

2]l

Preferences | Mail Setup | Mail Format | Spelling | Security | Other | Delegates

E-mail

Calendar

Calendar work week

Mon

First day of week:

First week of vear:
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Change the appearance of messages and the way they are handled.

Junk E-mail. .. l ’ E-mail Options. .. ]

Cuskomize the appearance of the Calendar.

Default reminder: 15 minutes w
Tue Wed Thu Fri []5at

Sunday W | Start kime: | 5:00 AM w

Starts on Jan 1 | End kime: 5:00 PM w
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Tip: customize the background color of your calendar by selecting Tools, Options, Calendar
Option and selecting the Background color of your choice.

Backaround calar: Flar

[ Juse selected background color on all calendars

Scheduling Appointments and Events

Use the Outlook Calendar to schedule single or recurring appointments and/or events. An
example of an Appointment can be a dentist appointment, hockey practice, soccer game,
grooming time for your pet, and several other things. An example of an Event would be an all
day seminar, an all day retreat, and so forth.

Reminders can be set up for each Appointment and/or Event. All reminders display in a dialog
box . Note: Outlook must be open in order to receive reminders.

[*]Reminder: |15 minutes w

15 minutes rs
20 minutes
1 howr

3 hours %

4 hours
S hours w

An Appointment is a calendar item that is to be added only to your own agenda. No other
participants can be added to an Appointment. To create a new appointment item on your
agenda (or someone else’s for which you are a Designate) choose New, Appointment.

Fiiil Roxi - Appointment

i Fle Edit Wiew Insert Format  Tools  Actions  Help Tip: .EaSin mark an eXiStIng
i | save and Close | =4 Il | 42¥Recurrence... | jluvite#ttendssﬂ ¥ 5| X]| b3 - | @ H Appolntment On the Calendar
tosoninat | stheting as Private by right-clicking
—— with the mouse on the
ubjech: oxl - -
Location: [South Hess 8 Lo [l oo 2 Appointment and choosing
Private from the menu.
Start time;, Wed 6/7/2006 v | [7s0am v Clalday event . . .
Erdtne:  |wedsile v |rzmom v Marking something as Private
[¥]Reminder: |15 minutes ~ Sheow time as: | [l Busy - WI” mask an anOIntment SO
that details can’t be seen by
other Outlook users.
I
© Computer Training and Support Services

Colorado State University

R:\Users\fparker\outlook\Outlook Calendar 2003.doc Page 3 of 11



Tip: By default, Outlook will schedule typical holidays for your Country as Calendar Events.
Add other Country Holidays by choosing Tools, Options, select the Preference tab, click on the
Add Holiday button located in the Calendar Options section of the dialog box.

Calendar Options [x]
Calendar wark week

[Jsun Man Tue Wed Thu Fti [5at

First day of week: | Sunday | Start time: IB!UU A V|
First week of year: |StartsonJanl  + | End time: |5!UU P b

Calendar options -

[]5haw week numbers in the Date Mavigatar

[=
Allow attendees to propose new times for meetings you organize

Use this response when yvou propose new meeting times: |Tentative » |

Background color: w | [ Planner Options... ] [ Add Holidays.

[[Juse selected background color on all calendars Add Holidays to Calendar E|

advanced options —

Select the locations whose holidays vou would like

@ []Enable alternate calendar: copied to your Outlook Calendar:

Syria A
Thailand _
Tunisia

Turkey

Urited Arab Emirates
United Kingdar
Urited States
Uruguay

Venezuela

Yemen

hen sending meeting requests aver the Internat, use

[ Free/Busy Options, ., ] [ Resource Schedulin

OOOECEOEEET

QK Car

&2

[ Ok ] [ Cancel
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Scheduling Meetings

There are several ways to create a new meeting in which you may invite other attendees. The
easiest way to start the process is to select the new button.

tew |||

e Choose File, New, Meeting Request

| Eile | Edit Wew Go Tools HateSpam  Ackions  Help
1 pew v |5 appointment Chrl+h
&en 4 j Meeting Reguest  Chrl+Shift+0

B CTSS - Staff Meeting - Meeting
i Bl Edi Insert Fgrmat  Tools  Actions  Help
i 5end | k'll] | i &, | ¥ Recurrence.., 3 Cancellpvitation | ¢ & | X | @ H

Alternate ways to create new meetings:
e Select an option from the Actions menu

Action: Help
:ﬁ e Appointment Chrl+M

Mew All Day Event
5] Mew Mesting Reguest  Chri+Shift+Q
Mew Meeting Request With »

E Plan a Meeting...
G View Group Schedules. ..

Mew Recurring Appointrient

[

Mew Recurring Meeting

mEE TP _Easily mark an existing
Appointment on the Calendar

Appointment Scheduling

Moren,Diane; Wimsen, Erik; Swenson, Trina <tswenson@ctss colostate. edu;
Subject: iZT53 - Staff Meeting

Location:  |Room 202, Weber v | Label: D Nore
Start time: Tue 8/1/2006 + |sooaM | []Alday event
End time: Tue &/1/2006 | [mooamM v

[¥lreminder: | 15 minutes R Shows time as: | [l Busy b

Meeting Warkspace. .. [ This is an online meeting using:

Please bring last months traiting information. Thanks.

as Private by right-clicking
with the mouse on the
Appointment and choosing
Private from the menu.
Marking something as Private
will mask an appointment so
that details can’t be seen by
other Outlook users.

< Private [ >

In the To... section, you may add persons from any of the Address Books available in Outlook,

including the Global Address List.

Tip: Create a Group View

Easily see free or busy time for more than one person by creating a group view of the invitees.
Once a group view has been created, it can be used repeatedly until removed. Create a Group
View by selecting Actions, View Group Schedule. Select the New button to create a list,
provide a unique group name, and add the invitees to the group. Use the group in a meeting
request by opening the group view from the Actions menu, View Group Schedule dialog box and

choose the Make a Meeting button.
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Scheduling: Identifying the Icons

## Untitled - Meeting

! File Edit ew Insert Format T

Meeting Organizer

Required Attendee

f:id5end | = | L & | £¥Recurr
Appointment Scheduling
Zoom: | 100% {Day Yiew) w |, Ju
EHIN
Al attendees N
{=1| 2 |Campana,Fran
=€) [Moren,Diane
{=| £ |Brake, Melod N

Optional Attendee
Resource icon

vVVvyyYyy

To Grant Calendar Permissions to Another Person

There are two different options when assigning permissions to your calendar account. One
option is to assign a specific user with specific permissions such as create and review for
scheduling items and/or folders/subfolders within the Preferences tab. The second option is to
delegate specific users for full permission on your account within Exchange using the Delegates

tab.

Preferences tab: Calendar Permissions for a
Specific User

Select the Calendar Options button from the

Preferences tab to display the Calendar options.
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Preferences | Mail Setup | Mai Format || Speling | Security | Other | Delegates

E-mail

‘; Change the appearance of messages and the way they are handled.
Junk E-mail, .. l ’ E-mail Cptions. .. ]

Calendar
i Customize the appearance of the Calendar,
E | I T e
Defaulk remindsr: 15 minutes ‘ Calendar Options. .. '
Tasks

= ] Change the appearance of tasks,
“ Task Options...

Change defaulk settings for contact and journal.

Rerminder tine: 2:00 AM

Contacts

8=

Contact Options... ] ’ Journal Options. .. ]

Maotes
Change the appearance of notes.

Moke Options. ..

a4 ] ’ Cancel
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From the Advanced Options section of the dialog box, select the Resource Scheduling button.

%Advanced options

@ [[]Enable alternate calendar: | | | |

Free/Eusy Options... Resource Scheduling. .. Time Zane. ..

Next, select the Set Permissions button from Resource Scheduling dialog box.

Resource Scheduling E|
Processing meeting requests

Lse tl'[,\\ie options if vwou are responsible For coordinating resources,
such astonference rooms,

[ Automatically accept meeting requests and process cancellations

‘ou must give users permission ko view and edit this calendar if you

want these options ko work offline.,
T

[ OK l [ Cancel ]

3] From the Calendar Properties dialog box, select the
Permission tab. Add users by selecting the Add

Calendar Properties

General Hormne Page Autodrchive

Adrinistration Farms | Permissions Synchronization b utton.
Mame: Pétmission Level:
Mone
Brake, Melady Editar
Anonymous Mone
[ Add... l [ Remove
Permissions
Permission Lewel: |None w
[J<create items [JFalder owner
[Jread items
[Jcreate subfolders [JFalder visible
Edit items Delete items
@ Mone @ Maone
D own O own
Oal Cal

[ [l 8 l[ Cancel ]
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Outlook will give you the option to search for a user within the Global Address List or other

available list.

Add Users E

Type Mame or Select From List: Showe Mames From the:

|c§ss | |Global Address List w |

| WENTE Business Phone Office
ckssTraining -
ckssusclal 1
ckssusclaln Camp
chssusclall Comp

Assign a permission level for each user that you add your
Calendar Options dialog box. Make sure the user is selected in
the list and then choose a permission level from the drop-down
menu.

Press the OK button when finished.
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Permissions

Permission Level:

Create items
Read items

Editar

Owner
Publishing Editor

Publishing Author

Author
[ create subfo Monediting Author
Edit items Reviewer
Contributor
(@ e
O own 7 Owin
@ al @ al
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A Different way to Share your Calendar

Your calendar can be shared with others as long as the proper permissions are set.

Cpen a shared Calendar. ..

C  Share My Calendar... )
Cuskomize Current Yiew. ..

From the Navigation Pane within Outlook select Share My Calendar.

b d

e ﬁ Mail
alendar, Properties §| . {EJ
—1 Add a user and assign

, .:d; Calendar
Genetal Home Page Autofirchive the app rop riate
Adrinistr ation Farms | Permissions Synchronization L.
permission level.
Mame: Permission Lesel:
Brake, Melody Editor
Anonyrmous Mone
[ Add... ] [ Remove
Permissions
Permission Lewvel: |None w
[create items [JFolder owner
[read items
[]create subfalders []Folder visible
Edit itams Delete items
() None %) None
O Chun O Cnun
Coall Call
I o]4 l l Zancel l

Open Another Person’s Folder
Once the owner of the Calendar folder has granted you the appropriate permissions, then you
may modify/schedule meetings on another’s agenda.

To open another’s folder, from the File menu, point to Open  [RlRUEEESEIRI

and click Other User’s Folder. In the Name box, enter the [ Hame.. ||l |
name of the person who has granted you delegate permission Folder type: | Calendar v ]
or click Name to select from the list. In the Folder box, click

the folder you want to open.
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Schedule A Meeting/Appointment For Another Person
With the other person’s calendar open, choose File, New, and choose either Appointment or
Meeting Request. Fill in the appropriate items such as Subject, Location, Start and End times,

etc.
Delegate

1. The person who wishes to grant the

permissions must log into his/her account in

Outlook and choose Tools, Options.
Click on the Delegates tab.
Click on the Add button and find the

no

person’s name in the Address Book that is
displayed. (The Address Book will display
all CSU faculty and staff members.) Click

on Add, then click on OK.

From the Delegate Permissions window,
click on the drop-down arrow next to
Calendar.
Choose the desired permission.

a.

from the calendar.

Reviewer — can read items only. A
Reviewer may not add or delete items

Preferences | Mail Setup | Mail Format || Spelling | Security | Other DE'ﬁﬁtES

Delegates

8

Delegates can send items on your behalf, To grant permission to
others ta access yvour Falders without also giving them
send-on-behalf-of privileges, go ko the Properties dialog box for each
fFalder and change the options on the Permissions tab.

Add...

Author — can read and create items. An Author may modify or delete only the

items which he/she added to the calendar.

X

Delepate Permissions: ctssusclal

This delegate has the Fallowing permissions

} __‘Ii (o0 ST it or (can read, create, and modify items) IR

Delegate receives copies of meeting-related messages sent to me
=

. f Tasks Editor {can read, create, and modify items) W

_,:J Inbox Maone v

8 —| Contacts | Mone w

Motes Mone %\'

H Journal Mone w

[ aukomatically send & message ko delegate summarizing these permissions

|:| Delegate can see my private items

OK ] [ Cancel
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Editor — can read, create, and modify items.

Permissions can be set for every item listed in
the Delegate Permissions dialog box per user.

Press OK when finished.
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Printing Your Calendar

Outlook Calendar has several Print styles to choose from when printing. Select and Preview the
different styles by choosing File, Print, and selecting a style from the Print Style section of the

dialog box. (N ]

Printer

[ ) Dai Iy Style Name: Dell Laser Printer 1700 w
Skatus:

L4 Weekly Tvi::s Dell Laser Printer 1700
‘Where: [CIPrint b File

[ ] Monthly Comment:

° T r i -fo I d Print this calendar: Copies

e Calendar Detail

Calendar ~

Print style

-~ Page Setup...

Mumber of pages: | all A

s

Mumber of copies: E

[ collate copies

Define Styles. ., ] ] “
weekly Style
...... “
------ Mrecilt vl
Print range
Stark: Fri 6/30/2008 W
End: Fri 6/30/2008 v

[JHide details of private appointments

Ok ] [ Cancel ] l Freview

CAUTION: Printing Errors That Can Occur

When printing a calendar that belongs to someone else, you may encounter a printer error
due to permission levels tied at the Task level. By default, when granting delegate
permissions on a calendar, the Tasks permissions are set to None. If you don’t have
permission to view Tasks, then you will not be able to print. The Print Page Setup dialog
box is set up to print Tasks by default and it will not work if you don’t have “permission”.

Modify the Page Setup from the File, Print menu:

Options

Layout: v
Include: [ ] TaskPad

[ hetes area (blank) Click the OK button when finished.
[ ]motes area {lined)

| Du:un't[:%rint Weekends
Print Exactly One Month Per Page

Make sure you deselect the Note options.

Help
For Help on any of the above or other items in MS Outlook, press the F1 key on the keyboard.
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